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top of the page to display the toolbar, and then click the Table of contents icon in the top left 
corner. In the Chrome browser, you would click the Bookmarks icon in the top right corner.) 
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Chapter 1: Welcome to Sage 100 
Contractor Installation 

Welcome to Sage 100 Contractor installation. Sage 100 Contractor can run in many different software and 
network environments, with implications you need to consider as you prepare to install the software. The 
more you understand about the installation process and how it relates to your software and network 
environment, the more likely your installation will proceed smoothly.

This chapter provides more information about customer resources, such as:

 l Other printed and printable guides

 l The user-assistance Help system

 l Contacts for Customer Support and other resources

 l Sage 100 Contractor training

 l Information about business partners.

How to read this document
This document uses the following conventions:

 l The names of screens, windows, fields, and other features displayed by the software are shown in 
bold type.

 l Information you enter into the software is in bold type, as in the following example:
Enter Miscellaneous in the Amount Type box.

 l Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key 
names indicates that you should press both keys at the same time; for example, SHIFT + TAB.

 l The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK] 
and [Post].

Tip: This symbol draws your attention to helpful information to make it easier for you to use Sage 100 
Contractor.

Note: This symbol draws your attention to information of particular interest, such as information not 
included in steps.
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Caution! This symbol draws your attention to information that is important because it can help you 
avoid a costly or time-consuming error.

Important! This symbol draws your attention to information that is of critical importance.

Customer Support and resources

Important! Before you contact Customer Support, take advantage of the following resources, which 
are available 24 hours a day, 7 days a week.

Check in Sage 100 Contractor Help

From anywhere in the Sage 100 Contractor software, you can display this comprehensive library of 
accessible topics to learn more about specific procedures, topics, fields, or buttons.

Read the product documentation 

The software comes with several PDF guides, including Release Notes, Installation and License 
Administration Guide, and User Guide, among others. 

To view the guides, click Home & Resources tab > Product Documentation or, if you have Activity Centers 
hidden, click Resources > Printable Documentation. 

Ask the community at Sage City 

Join industry peers, certified partners, and Sage professionals online 24/7 in the Sage City General 
Discussion forum—the best place to ask questions and share product experiences, tips, and tricks.

You can also check Sage City for the latest product alerts. Keep up with the latest product information in 
the Sage City Announcements, News, and Alerts forum. 

Search in Sage Knowledgebase

Depending on your Sage service plan, we offer a web-based Sage Knowledgebase and online user 
community forums through the in-product menu or by visiting www.sagekb.com in your browser. Our staff 
maintains an extensive knowledge database of questions and answers covering everything from 
frequently asked questions to more complex problems and solutions. This online tool is the same tool we 
use in our customer support call center to help answer your call. 
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To log in to Sage Knowledgebase:

 1. Go to www.sagekb.com. 

 2. In the upper-right, on the menu bar, click Log on. 

 3. Enter your Username and Password. 

 4. Click Log on.

Contact Customer Support through Live Chat

Click the [Live Chat] button Monday through Friday, from 9 am to 8 pm ET to start a conversation with a 
customer support analyst. The [Live Chat] button is available in the lower left corner of the Home window.

Our analysts work with you to respond accordingly to the urgency of your issue. Call urgency can range 
from a simple explanation of software settings to critical situations in which work is stopped or data integrity 
is compromised. Some calls may warrant further research and followup, in which case our support analyst 
will place your call in his/her in-progress work list. At every step of the way, we work with you until we reach 
a resolution or agreement.

Depending on your Sage service plan, you may check the status or update, or even create a new support 
ticket online:

 1. Visit https://customers.sagenorthamerica.com/irj/portal/anonymous/login.

 2. Enter your Customer Portal Username and Password.

 3. Click Log on.

 4. On the right, click the Cases button.

Before you contact Customer Support

Be sure to have the following information on hand so we can handle your inquiry efficiently.

Question How to Find the Answer

What is your Sage client 
ID number?

Your client ID number can be found on correspondence you receive from 
Sage. If you do not know your Sage client ID, contact the person at your 
company who maintains your relationship with Sage.

What software version are 
you using?

To find the version, open Sage 100 Contractor; click Help > About Sage 
100 Contractor and note the number listed.

What application or area in 
the software are you 

On the menu list, identify the application and window where are you are 
working (i.e. Selecting Invoices to Pay in 4-3-1, Accounts Payable Vendor 

Information for Customer Support
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Question How to Find the Answer

calling about? Payments). 

How can we help you? Walk through the exact steps you completed with as much detail and 
accuracy as possible. 

Is there an error 
message?

Write down the exact wording of the message.

Can you reproduce the 
issue?

Were you able to walk through the same steps that led to the problem and 
see whether it happened again?

Is this the first time the 
problem has happened? 
Does the problem occur 
on one workstation or 
several?

Ask other users if they have experienced the same problem. Have them 
test at their workstation to see if they experience the same problem. Also, 
have the original user try other workstations to see whether the problem is 
specific to that user.

Has anything changed 
with your software, 
hardware, or workflow?

Ask your network administrator for technical information regarding 
anything that may have changed behind the scenes: upgrades to Sage 100 
Contractor, new third-party software installations, moving of data from one 
server to another, new printers or print driver installation, or anything else 
that might affect the network.

Does the problem happen 
in the sample data sets?

Select [File> Open Company], then change the drive letter on the 
dropdown to C:, select Sample Company.

Training resources
When you choose to take online classes from Sage or work with a Sage business partner, you will learn 
how to use Sage 100 Contractor to support your business. Contact your business partner to find out about 
training options or visit Sage University at http://www.sageu.com.

Online classes

Online classes help you maximize your use of Sage 100 Contractor. Online classes are a convenient 
training option for your company and new users to learn more about Sage 100 Contractor so you can get 
the most out of the software.  You can select from classes on all aspects of Sage 100 Contractor, including 
project management, estimating, scheduling, service management and payroll. Each online class is led by 
an instructor with years of experience using Sage 100 Contractor. During the class, you will be able to 
follow along as the instructor demonstrates functions and workflows in Sage 100 Contractor. In the online 
live session, you can ask questions and benefit from hearing answers to other students' questions.
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For more information, visit http://www.sageu.com.

Getting started as a new user

We recommend that all new users should begin with our New Customer Training (NCT) series, which is 
included in our Essentials Training Package in recorded format for 24/7 access. If you prefer live online 
training led by an instructor, you can register for the Realtime Learning version of these NCT courses. For 
more information, visit http://www.sageu.com.

Business partners
To serve you better, Sage 100 Contractor products and services are available to you through an 
authorized network of business partners. Business partners have local expertise and regional knowledge 
working with contractors in the region.

Your business partner is available to serve you, from simple how-to questions and hands-on 
demonstrations, to installation, implementation, and training. They're fully equipped to help you get where 
you want to be. For more information, contact your Sage 100 Contractor business partner.

The Users Group (TUG)
TUG, The Users Group for Sage 300 Construction and Real Estate, Sage 100 Contractor, and Sage 
Estimating is a not-for-profit, professional organization committed to supporting the users of Sage 100 
Contractor and other Sage construction software.

You can find out more about the group, their services, and how to become a member at http://tugweb.site-
ym.com/default.asp?.

Business forms
Sage 100 Contractor is designed to work with generic cheques and forms that are available from many 
sources. There is no single vendor that customers must use. However, you can get a complete portfolio of 
forms, tax forms, and cheques through Sage Construction and Real Estate Forms by calling 800-760-7929 
or by visiting www.sagecreforms.biz. 
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Chapter 2: System Configuration

This chapter presents technical information about how to configure Sage 100 Contractor for specific 
operating systems.

For current information about supported operating systems, Internet browsers, and other software, and 
about system requirements for servers and client workstations, refer to our Knowledgebase article ID 
98460, available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=98460.

Make sure your computers meet the system requirements before you install the software. Sage 100 
Contractor may not run properly or at all on computers that do not meet the minimum requirements. 

About installing and configuring Microsoft SQL Server 
Sage 100 Contractor 2019 requires an instance of Microsoft SQL Server or Microsoft SQL Server Express.
 

If you do not already have a SQL Server instance, you can choose to download and install SQL Server 
Express when you open Database Administration for Sage 100 Contractor. If you do so, the installation 
program configures a SQL Server instance with optimal settings for running Sage 100 Contractor. 

Note: Microsoft recommends against installing SQL Server on a domain controller, and does not 
support SQL Server on a read-only domain controller should you encounter any problems with this 
configuration. For more information, see the Microsoft Knowledgebase article 
https://support.microsoft.com/en-us/kb/2032911.

If you already have an instance of SQL Server installed, and you want to use it for your Sage 100 
Contractor company, Database Administration will attempt to configure this instance for you when you 
connect. 

Important! For tighter security, we strongly recommend that you create a SQL Server Instance 
exclusively for Sage 100 Contractor databases, ensuring that only approved applications have 
access to the SQL Server database. 
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About .NET Framework

.NET 4.6.1 Framework is required

If Microsoft .NET 4.6.1 Framework is not already installed, it will be installed automatically when you install 
Sage 100 Contractor. Installation of .NET 4.6.1 Framework alone may take up to 20 minutes per computer.

Make sure that both your client and server computers meet the minimum requirements for installing both 
Sage 100 Contractor software and .NET 4.6.1 Framework. 

Note: If Sage 100 Contractor requires an installation of .NET 4.6.1 Framework, the Sage 100 Contractor 
installation process may continue automatically after the .NET Framework installation is completed. If 
you are prompted to restart your computer after the .NET Framework installation, you must do so to 
continue the Sage 100 Contractor installation. 

.NET 3.5 is also required

In some situations, you may need to turn on .NET 3.5 manually by selecting the .NET 3.5 check box in the 
Windows Features dialog box. For more information, see Knowledgebase article ID 68381, available at 
https://support.na.sage.com/selfservice/viewdocument.do?externalId=68381.

Installation of Microsoft SQL Server on a domain controller is 
not recommended
Microsoft recommends against installing SQL Server on a domain controller, and does not support SQL 
Server on a read-only domain controller should you encounter any problems with this configuration. 

Because you must install Database Administration on the same machine as SQL Server, you should not 
install Database Administration on a domain controller. To guard against inadvertent installation on a 
domain controller and the potential for irrecoverable data losses, you will receive a warning if you attempt 
to install Database Administration on a machine used as a domain controller .

For more information, see the Microsoft Knowledgebase article https://support.microsoft.com/en-
us/kb/2032911.

Internet access required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling  tax forms, submitting enhancement requests, 
accessing Help, or downloading periodic product or tax updates all require Internet access. 
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To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is 
installed on has access to the Internet. 

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able 
to connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses 
for each computer where   Sage 100 Contractor is installed, then disconnect the Sage license server from 
the Internet. 

Network configuration and licensing

About network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to 
enable communication among computers on a network. By default, Sage 100 Contractor uses the 
TCP starting port 48760. Certain configurations can potentially disable the communication: 

 l You must enable file sharing on your computers. To enable file sharing, follow the instructions in the 
Windows  Help.

 l TCP communication requires the selection of port numbers that are not in use by other processes 
on the local computer. 

 l Software firewalls running on the local computer can be configured to block processes from opening 
TCP ports, which will prevent communication through the TCP Remoting Channel. 

Configuring Sage 100 Contractor Hosting Framework TCP port number

Sage 100 Contractor uses the TCP starting port number 48750 as the default. You can configure the port 
number using the XML file Sage.CRE.HostingFramework.Service-InstanceConfig.xml, located in the 
Programs (x86)\Sage\Sage 100 Contractor folder.

Warning! If you need to change the default port numbers for the Sage 100 Contractor Hosting 
Framework using the Sage.CRE.HostingFramework.Service-InstanceConfig.xml file, you must change 
it on every computer on the network where Sage 100 Contractor is installed. In addition, after making 
this change, the Sage 100 Contractor Hosting Framework on each computer running Sage 100 
Contractor must be restarted. 

Note: Consult your IT administrator for alternative port numbers. 

To change the port numbers: 

 1. In Window Explorer, locate Sage.CRE.HostingFramework.Service-InstanceConfig.xml in the path 
Programs(x86)\Sage\Sage 100 Contractor.
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 2. Right-click Sage.CRE.HostingFramework.Service-InstanceConfig.xml, then open it with a text 
editor, such as Notepad. 

 3. Near the end of the file, between the <StartingPort> </StartingPort> tags, locate the port number.

 4. Change the port number. 

 5. Save, and then close the file. 

Repeat these steps on every computer running Sage 100 Contractor. 

Configuring anti-virus software and third-party firewalls

During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured 
automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some 
other firewall, however, you may need to manually adjust some settings in the firewall in order to ensure 
proper operation.

You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 
100 Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually 
configuring other third-party firewall products.

To configure the Windows Firewall:

 1. For Windows Server 2008, click Start > Control Panel > Security. 

For Windows 7, click Start > Control Panel > System and Security.

For Windows 8.1 and Windows 10, click Start > All apps > Control Panel > System and Security.

 2. Open Windows Firewall, and then select Allow a program or feature through Windows Firewall.

 3. Select Sage 100 Contractor Hosting Framework on the list, if it is not selected.

Note: By default, the exception is set to allow access by any computer on the network. You can refine 
this setting by selecting the Change Scope button. Be aware that restricting the scope incorrectly can 
cause the computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 32-bit

 l C:\ProgramData\Sage\Sage 100 Contractor SQL

 l C:\Program Files\Sage\Sage 100 Contractor SQL

 l C:\ProgramData\Aatrix Software SQL

 l C:\Program Files\Aatrix Software SQL

 l C:\%LocalAppData%\Sage\Sage 100 Contractor SQL
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 l Network location of Sage 100 Contractor SQLdata. (If you install SQL Server Express using 
Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 64-bit

 l C:\ProgramData\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Aatrix Software SQL

 l C:\ProgramData\Aatrix Software SQL

 l C:\%LocalAppData%\Sage\Sage 100 Contractor SQL

 l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database 
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

 l C:\ProgramData\Sage\Sage 100 Contractor

 l C:\Program Files\Sage\Sage 100 Contractor

 l C:\ProgramData\Aatrix Software

 l C:\Program Files\Aatrix Software

 l C:\%LocalAppData%\Sage\Sage 100 Contractor

 l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database 
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit

 l C:\ProgramData\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Aatrix Software SQL

 l C:\ProgramData\Aatrix Software SQL

 l C:\%LocalAppData%\Sage\Sage 100 Contractor SQL

 l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database 
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 

 l C:\ProgramData\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Aatrix Software SQL

 l C:\ProgramData\Aatrix Software SQL
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 l C:\%LocalAppData%\Sage\Sage 100 Contractor SQL

 l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database 
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for  Windows Server 2008 R2, 2011, 2012

 l C:\ProgramData\Sage\Sage 100 Contractor SQL

 l C:\ProgramFiles (x86)\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Aatrix Software SQL

 l C:\ProgramData\Aatrix Software SQL

 l C:\%LocalAppData%\Sage\Sage 100 Contractor SQL

 l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database 
Administration, this location is C:\Sage100Con\Company\.)

Windows permissions required for Sage 100 Contractor
When you install Sage 100 Contractor, work with your system administrator to configure the Windows-level 
security that corresponds to the operating system installed on each workstation where Sage 100 
Contractor will be used. Without the correct permissions, users may have difficulty operating Sage 100 
Contractor.

Caution! Always back up your data before changing Windows permissions! Setting Windows security 
incorrectly can adversely affect system operations. Sage is not responsible for problems caused by 
incorrectly configured Windows settings.

All the directories listed below must have Full Control, Modify, Read & execute, List folder contents, Read, 
and Write permission. Special permissions are not required.

Windows component/
version

Directories

Registry Keys HKEY_Current_User\Software\Sage
HKEY_Local_Machine\Software\Wow6432node\Sage
HKEY_Current Config\Software\Sage 100 Contractor PDF 
Export
HKEY_Current Config\Software\Sage 100 Contractor RTF 
Export 

Windows 8.1 Professional 32-bit C:\Sage100Con
C:\ProgramData\Sage\Sage 100 Contractor 

Permissions required
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Windows component/
version

Directories

C:\Program Files\Sage\Sage 100 Contractor
C:\ProgramData\Aatrix Software
C:\Program Files\Aatrix Software 
C:\%LocalAppData%\Sage\Sage 100 Contractor 
Network location of Sage 100 Contractor data 

Windows 8.1 Professional 64-bit C:\Sage100Con 
C:\ProgramData\Sage\Sage 100 Contractor 
C:\Program Files (x86)\Sage\Sage 100 Contractor 
C:\Program Files (x86)\Aatrix Software 
C:\ProgramData\Aatrix Software 
C:\%LocalAppData%\Sage\Sage 100 Contractor 
Network location of Sage 100 Contractor data  

Windows Server 2008 R2, 2011, 
2012

C:\Sage100Con  
C:\ProgramData\Sage\Sage 100 Contractor  
C:\ProgramFiles (x86)\Sage\Sage 100 Contractor 
C:\Program Files (x86)\Aatrix Software  
C:\ProgramData\Aatrix Software 
C:\%LocalAppData%\Sage\Sage 100 Contractor 
Network location of Sage 100 Contractor data 

Report scheduling and faxing functionality

About setting up faxing and emailing through Sage 100 Contractor

Requirements for faxing 

Using the faxing functionality through the Sage 100 Contractor program requires: 

 l Installation of the Windows operating system Fax Service component.

 l A separate installation and setup of a fax modem in your workstation.

 l Access to an analog phone line. 

In addition, you must set up cover page information and specify the number of times to try to send a fax 
that does not go through immediately. 
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For more information about installing and setting up your fax modem, refer to the documentation that 
came with your fax modem. Sage 100 Contractor does not provide support for installing or setting up a fax 
modem.

For more information about installing the Windows operating system Fax Service component, see 
Installing the Window Fax Services component.

Upgrade to the latest version of Adobe Reader

Adobe Reader supports faxing from Windows. To fax from Sage 100 Contractor, you should download and 
install the latest version from http://get.adobe.com/reader/.

Turn off automatic updating for Adobe Reader

If you use report scheduling to send faxes, we recommend that you turn off automatic update checking for 
Acrobat Reader, so that updates do not interfere with faxing of scheduled reports.

Note: Instructions for turning off automatic update checking differ from version to version of Adobe 
Reader. Refer to the Adobe Reader Help for instructions. 

Report scheduling and emailing 

Important! Emailing from Sage 100 Contractor requires  Microsoft Outlook or access to a simple mail 
transfer protocol (SMTP) email server. 

You can send email from Sage 100 Contractor:

 l Using Microsoft Outlook. 

 l Using the company's default SMTP connection.

 l Using an alternate SMTP connection.

You use the Email Settings window to select your preference. 

Open the Email Settings window in one of these ways: 

 l In a Report Printing window:

 1. On the toolbar, click the Email button.

 2. In the  Email Distribution window that opens, click the Email Settings button.

 l In the 7-6 Alerts Manager, click the Email Settings button.

 l In the Dispatch Board , click Settings > Email Setup.
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Sage 100 Contractor and SMTP

Important! The SMTP server may be located on your workstation PC, on a server on your company’s 
network, or at your Internet service provider (ISP). If the email server is local, you may need the 
assistance of an IT professional to properly identify or set up this capability. If the email server is 
located at your ISP, you may need to contact your ISP for assistance. 

Using the ISP’s simple mail transfer protocol (SMTP) server to send email via Sage 100 Contractor 
typically requires user authentication at the STMP server. (An example of an SMTP email server name is 
smtp.att.sbcglobal.net.) Different ISPs may use different terms when referring to user authentication. 
Generally, user authentication means refers to checking that your user name and password are valid. 

When sending email through Sage 100 Contractor using an ISP’s SMTP server, you supply only your user 
name and password for the ISP’s SMTP server. You do not submit your: 

 l Sage 100 Contractor user name and password.

 l Network domain user name and password.

 l Windows system user name and password. 

Note: We do not provide support for setting up or installing an email server. You set up user 
authentication and your fax line access dial out number on 7-1 Company Information.

Installing the Windows Fax Services component

To fax from Sage 100 Contractor, you must install the Windows Fax Services component:

Windows 8.1 

 1. Click Start > All apps > Control Panel > Programs > Turn Windows features on or off.

 2. On the Windows Features window, locate Print and Document Services, then click the Windows fax 
and scan check box. 

 3. Click [OK].

Windows Server 2012

Detailed information from Microsoft
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Chapter 3: Sage 100 Contractor Installation

This chapter provides detailed information and instructions for installing Sage 100 Contractor software in 
different environments, such as:

 l Single user

 l Peer-to-peer

 l Network

It also describes how to install the software in a new environment, and how to upgrade the software and 
your company data from an earlier version.

Installation Overview
This section provides an overview of all the important steps you should complete to install version 22.4. 
Review it carefully before you install Sage 100 Contractor and set up your company or migrate your 
company from version 19.8.  

Later sections in this chapter cover installation tasks in greater detail.

Tip: Download and print the Quick Start Checklist from our website. Then check off each step on the 
printed list as you complete the necessary tasks. 

Note: If this is a new installation of Sage 100 Contractor, you do not perform the steps to migrate your 
data or to "go live" using migrated company data with Sage 100 Contractor version 22.4.

 1. Review hardware and software requirements

Verify that the computer on which you plan to install Sage 100 Contractor 2020, and each 
workstation that requires access to Sage 100 Contractor 2020, meets the minimum system 
requirements.

For current information about supported operating systems, Internet browsers, and other 
software, and about system requirements for servers and client workstations, refer to our 
Knowledgebase article ID 98460, available at 
https://support.na.sage.com/selfservice/viewdocument.do?externalId=98460.
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Important! Software not listed in the System Requirements article have not been tested 
by Sage Software, and are not supported. If you try to use a newer version of the 
software, or use software not listed, you may encounter technical difficulties.

Confirm that the Sage 100 Contractor  server meets the minimum system requirements.

Confirm that each client workstation meets the minimum system requirements.

Confirm that the server and each workstation meet the minimum software requirements 
(database, operating system, Microsoft programs, and so on).

 2. Review the Sage 100 Contractor documentation

Besides this  Installation and Administration Guide, you should read and understand the 
following documentation before you proceed with installation:

Sage 100 Contractor Version 22.4 Release Notes (U.S;Canada)

Sage 100 Contractor Version 22.4 Database and Company Administration Guide 
(U.S.; Canada)

 3. Install and set up Sage 100 Contractor 2020

 a. Install Sage 100 Contractor 2020 on the machine you will use as the license server, choosing 
the options to install the License Server, Database Administration, and Sage Advisor Update. 

Note: If you have been using an earlier version of Sage 100 Contractor, install the license 
server on the same machine as your version 19.8 license server. Sage 100 Contractor 
2020 was designed to co-exist with version 19.8 and share the same license entitlements.

Important! Do not attempt to install Database Administration on a domain controller. You 
must install Database Administration on the same server as Microsoft SQL Server, which is 
not supported on a domain controller. For more information see the Microsoft 
Knowledgebase article https://support.microsoft.com/en-us/kb/2032911. 

For detailed steps on new installations of Sage 100 Contractor, see New installations.

For detailed steps on installing an upgrade to Sage 100 Contractorversion 22.4, see Upgrade 
installations.

 b. Use the Database Administration tool to connect your company database to Microsoft SQL 
Server. 
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Tip: If you do not have an instance of Microsoft SQL Server, click the link to install and 
configure SQL Server Express. 

For more detailed information about installing and configuring Microsoft SQL Server, see 
About installing and configuring Microsoft SQL Server 

 c. Use the Database Administration tool to deploy the Sample Company data. 

For more information about deploying sample data, see About deploying the Sample 
Company.

 d. If you have been using an earlier version of Sage 100 Contractor, migrate your company from 
version 19.8.

Use Database Administration for Sage 100 Contractor to migrate your company to version 
22.4. If you have multiple companies, migrate your principal company and complete the 
remaining tasks on this checklist for that company. Do the same for other companies, later.

Use the Database Administration tool to migrate your Sage 100 Contractor company 
folder from version 19.8. 

Use the Database Administration tool to migrate your custom reports. 

Migrate archive companies, as needed. (You can leave your archive companies in 
version 19.8 if you prefer.)

For more detailed information about migrating your data, see Migrating your company data 
from version 19.8

 4. Ensure that company administrators and sysadmin users have administrator rights on the server

Make sure that users who will have company administrator or sysadmin rights in Sage 100 
Contractor 2020 also have Windows administrator rights on the server that is hosting your 
SQL Server database. 

Important! You may need to work with your IT department to accomplish this task.

 5. Assign permissions to sysadmin users

Use the Database Administration tool to assign sysadmin rights to at least one other user.

 6.  Assign permissions to company administrators 

In Sage Sage 100 Contractor2019, use the 7-2-2 User List to designate company 
administrators. 
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If you have been using a previous version of Sage 100 Contractor, designate former 
supervisor users as company administrators.

Tip: See the User List help for tips on copying Supervisor defaults from version 19.8 to 
company administrators in Sage 100 Contractor 2020.

 7. When you and your users are ready, use Sage 100 Contractor 2020 in a production (“live”) 
environment

Important! If you have been using a previous version of Sage 100 Contractor, follow the steps 
in Ready to “go live” with Sage 100 Contractor 2020  to move your company data to your 
production environment, migrate scheduled reports and alerts, make sure third-party 
applications that read and write to Sage 100 Contractor 2020 are connected properly to your 
new company database, and then stop using version 19.8.

Pre-installation information for new customers

To harness the full power of Sage 100 Contractor, you must thoroughly plan the implementation and use of 
this software in running your business. Before you can start working in the program, you must also transfer 
your existing company data to Sage 100 Contractor. Your business partner can assist you with a data 
migration and business implementation plan. For more information about implementing Sage 100 
Contractor for your company, see the information about business partners in Chapter 1 of this guide.  

We recommend that you take advantage of all the knowledge and advice available in Sage 100 Contractor 
documentation and training classes. We also recommend that you work with your business partner and 
accounting professionals before you begin to implement this software for your business.  

Important! We recommend that you install the Sage license server on a computer that is always 
available to other computers on your network that are running Sage 100 Contractor.

Pre-installation information for existing customers

As an existing customer working with company information and possibly with scheduled reports,  you 
should review these important points before you install the program.

Important! To migrate your data from version 19.8 to version 22.4, you must install version 22.4 on the 
same computer as version 19.8. You should confirm that this computer's processor, memory, and free 
disk space are sufficient for a second installation of Sage 100 Contractor plus Microsoft SQL Express. ( 
For current information about supported operating systems, Internet browsers, and other software, and 
about system requirements for servers and client workstations, refer to our Knowledgebase article ID 
98460, available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=98460.)
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Note: Before you install version 22.4, make at least one backup, but consider making two backup copies 
of your existing company data for an extra margin of safety. 

Upgrade Paths

To upgrade to Sage 100 Contractor (SQL), you must first upgrade to version 19.8.  

Upgrade 
From

 
Upgrade Path

19.8 Migrate your data to version 22.4 using the utility in Database Administration for Sage 
100 Contractor

19.x Upgrade versions 19.8 and earlier to version 19.8

18.x Upgrade directly to version 19.8

17.x Upgrade to 18.x, reindex your data, and then upgrade to 19.8

16.x Upgrade to 18.x, reindex your data, and then upgrade to 19.8

15.x Upgrade to 18.x, reindex your data, and then upgrade to 19.8

14.x Upgrade to 18.x, reindex your data, and then upgrade to 19.8

13.x Upgrade to 14.x, reindex your data, and then upgrade to 19.8

12.x Upgrade to 13.x, reindex your data, and then upgrade to 19.8

11.x Upgrade to 13.x, reindex your data, and then upgrade to 19.8

10.x Upgrade to 13.x, reindex your data, and then upgrade to 19.8

Upgrade paths from earlier versions

Duration of the installation process

Plan on at least five and possibly up to 20 minutes per computer to install Sage 100 Contractor. The 
duration of the Sage 100 Contractor installation depends a great deal upon each computer’s configuration. 
For example, some newer computers come with pre-installed software required to run Sage 100 
Contractor software, such as the .NET 4.6.1 Framework. Installation to older computers may take more 
time.

If Microsoft .NET 4.6.1 Framework is not already installed, it will be installed automatically when you install 
Sage 100 Contractor. Installation of .NET 4.6.1 Framework alone may take up to 20 minutes per computer, 
and you may be prompted to restart your computer after the .NET installation.
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Also, if you install Microsoft SQL Express when you first open Sage 100 Contractor Database 
Administration, plan on about 20 minutes to download, install, and configure SQL Express. (You only have 
to do this one time.)

Additional required software

Microsoft SQL Server or Microsoft SQL Express must be installed on the same machine as Sage 100 
Contractor  Database Administration.

Microsoft .NET 4.6.1 Framework must be installed on all computers running Sage 100 Contractor 
software. The installer determines whether .NET 4.6.1 Framework is already installed, and if it is not, it 
installs the required software automatically.  Plan for an additional 20 minutes per computer to install .NET 
4.6.1 Framework. 

Important! When installing on a server, you should make sure that no other users are logged onto 
the machine. The Sage 100 Contractor installation process may continue automatically after the 
.NET Framework installation is finished. If you are prompted to restart your computer after the .NET 
Framework installation, you must do so to continue the Sage 100 Contractor installation. 

Note: It is very important to understand the network environments and operating systems on the 
computers and server computers where you install Sage 100 Contractor software. For detailed 
information about installing to different environments, see  Special Configurations—Operating Systems 
and Services. 

About Sage Advisor Update

When you install Sage 100 Contractor on a server or a workstation, you can select an option to install Sage 
Advisor Update. We recommend that you install it.

Sage Advisor Update is a notification and download service that alerts you when an update is available for 
Sage 100 Contractor. You can use Sage Advisor Update to download and install updates available for 
Sage 100 Contractor and other Sage products for which you have a current Sage Business Care Plan.

Important! You must be connected to the Internet to use Sage Advisor Update.

Double-click the Sage Advisor Update  icon in your Windows system tray at any time to:

 l View and manually check for updates that are available for your Sage products.

 l Specify the frequency and time of day to check for updates. 

 l Specify a location on your computer to download updates.

 l Set up email notifications to alert you by email when updates are available. 

20Sage 100 Contractor 2019 (SQL) Installation and License Administration Guide Canada Edition



 l View update history for your Sage programs.

 l View the status of your Sage Business Care plan.

You can also open Sage Advisor Update by clicking Start > Programs > Sage > Sage Advisor Update.

For more information, see "Configuring Sage Advisor Update" (page 26)

Tip: Use the Customize settings in the Windows system tray to make sure you can view the Sage 
Advisor Update icon and notifications from the System Tray in your Taskbar.

About installing the Sage 100 Contractor software to different configurations

You can install Sage 100 Contractor software to many different configurations, for example, stand-alone, 
network server, Citrix and Terminal Services servers, peer-to-peer, and workstations. 

Important! To migrate your data from version 19.8 to version 22.4, you must install version 22.4 on the 
same computer as version 19.8. You should confirm that this computer's processor, memory, and free 
disk space are sufficient for a second installation of Sage 100 Contractor plus Microsoft SQL Express. ( 
For current information about supported operating systems, Internet browsers, and other software, and 
about system requirements for servers and client workstations, refer to our Knowledgebase article ID 
98460, available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=98460.)

Important! The optimal operational size of a peer-to-peer network running Sage 100 Contractor is 
two to five workstations. Additional workstations may adversely impact Sage 100 Contractor 
response times. Networks consisting of more than five (5) workstations may need to use one 
computer as a dedicated server.  

Sage 100 Contractor allows users to share data and reports stored on a network hard drive. From different 
workstations, users can then access the server to share one set of data, one set of reports, and one set of 
report forms. 

During installation, the installer checks for the components necessary to run Sage 100 Contractor and then 
copies the program modules and standard reports to the Programs (x86) folder and subfolders on the hard 
disk. In addition, the installation process copies system files necessary for program operations to the 
Windows and Windows System folders. 

The installation process does not make any configuration changes to the computer. After installation is 
complete, you must configure the stand-alone computer, server computer, or workstation for optimal 
performance.

Microsoft SQL Express is not installed when you install Sage 100 Contractor. When you open Database 
Administration, the connection window provides a link to download and install SQL Express automatically. 
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Alternatively, you can let Database Administration configure an existing instance of Microsoft SQL Server 
or SQL Express for use with Sage 100 Contractor.

For detailed information about configuring each server and workstation depending on its operating 
system, see Chapter 8 Special Configurations—Operating Systems and Services.  

Connectivity across your network

For client workstations to run Sage 100 Contractor, they must all be connected to the Sage license server 
and to the computer that hosts the SQL Server instance you are using for Sage 100 Contractor. 

If only one user sees the “Sage 100 Contractor can’t communicate with the designated Sage license 
server” message when all other users are connected, you know that the connectivity problem is limited to 
that one person. If you encounter a hardware failure with your license server, then no one will be able to 
run Sage 100 Contractor.

Mapping a network drive to access a company

You may have to map to a network drive to access a Sage 100 Contractor company if it is not located on a 
drive on your local computer. Let’s suppose that the company has been moved to network drive Z: Now to 
access the company data, you have to map to drive Z.

To map a network drive to access a company:

 1. On your Windows desktop, click Start > Explore.

 2. On the toolbar, click Tools > Map Network Drive.

 3. On the Map Network Drive window, click [Browse].

 4. Locate the drive, and then click [OK].

 5. On the Map Network Drive window, click [Finish].

 6. On the Company List window, select drive Z.

 7. Select the company, and then click [OK].

About deploying the Sample Company

Note: We highly recommend that you or your system administrator (if you are not the "sysadmin" user) 
deploy the Sample Company using the Database Administration for Sage 100 Contractor tool. 

The Sample Company provides the means for viewing and working with sample data in Sage 100 
Contractor windows. There are sample accounts, sample employees, sample takeoffs, and much more. 
By viewing and working with this sample data, you can gain an understanding of how different windows 
interact with the sample data when managing a construction business with Sage 100 Contractor.  
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Sage 100 Contractor master trainers use the Sample Company extensively during Sage 100 Contractor 
training classes. 

You can log on to the Sample Company using one of the sample user names. Alternatively, your company 
administrator can add you as a user to Sample Company so that you can log in using your usual Windows 
or SQL password.  

The Sample Company: 

 l Allows you a safe way to try out new functions as you learn them. 

 l Is used in many online and recorded classes. 

 l Provides samples of many Sage 100 Contractor forms that are all filled in. This makes it easy to 
understand many concepts. 

 l Provides starter lists for many values you will need to set up, including cost codes, cost types, tasks, 
client status, client type, employee positions, paygroups, and so on. 

 l Provides live data for Sage 100 Contractor reports. 

 l Takes very little space on your hard disk drive. 

Note: Deploying or redeploying the Sample Company overwrites any previous installations of the 
Sample Company.  If you have made changes in your Sample Company that you want to keep, rename 
this folder before installing a fresh copy of the Sample Company.  

Caution! You should use only Sage 100 Contractor Database Administration to deploy, delete, 
rename,  back up, or restore the Sample Company. The Database Administration tool performs 
functions necessary to maintain the integrity of your Sage 100 Contractor data, and these functions 
are not available in SQL Server or SQL Server Express.

Where To Now?

If you are installing the Sage 100 Contractor software on a computer that has never had Sage 100 
Contractor installed on it before, refer to the "New installations" (page 23) section for instructions on 
installing and setting up the software for the first time.

If Sage 100 Contractor is already installed on your network computers, refer to the "Upgrade installations" 
(page 28) section for instructions on upgrading or updating the software.

New installations
By "new installation" we mean  installing the software on a computer that has never had Sage 100 
Contractor installed on it before.

23Sage 100 Contractor 2019 (SQL) Installation and License Administration Guide Canada Edition



Note: Instructions for reinstalling or upgrading an existing installation are different. See Upgrade pre-
installation tasks. 

You must designate one computer on your network as the Sage license server. This server will manage 
use of Sage 100 Contractor (for example, the number of people who can use Sage 100 Contractor 
simultaneously on your network). You must install the software on this computer first, and then activate 
your licenses before installing Sage 100 Contractor on your other computers. 

Copy the entire set of installation files (all files and folder) to a folder that you create on a network drive. 
Install the program to each client workstation by launching the installation on the network folder from that 
client workstation. We recommend that you install to the Sage license server computer first. Then, when 
you install the program to your workstations, you can set up Sage 100 Contractor to find the Sage license 
server and run the program using your license.  

The installation process also presents different installation windows depending on whether you are 
installing Sage 100 Contractor as the Sage license server  or you are just installing Sage 100 Contractor by 
itself. 

Important! Always start installing the program at the computer that will be your Sage license server, 
which is likely to be your network server. 

Basic steps for new installations are:

 1. Install the program on your network server, the computer where all your company data is located. 
You do this only once on your network. 

Note: Remember to write down the Sage license server computer’s IP Address and/or computer 
name, which is displayed at the end of the installation. 

 2. Activate your licenses. 

 3. Install the program to all client workstations on your network. 

 4. From each client workstation, specify the Sage license server. 

Installing Sage 100 Contractor on the Sage license server

Use these instructions for the following types of installations:

 l You are installing Sage 100 Contractor on the computer you will use as the Sage license server in a 
networked environment.

 l You are installing Database Administration either in a networked environment, or on a single 
computer that is not networked with other computers running Sage 100 Contractor(a stand-alone 
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installation).

Note: You do not need to install Database Administration on the same server as the Sage 
license server, although this is a practical configuration. 

 l You are installing Sage 100 Contractor on a single computer as a stand-alone installation.

To install  from a download package unzipped into a local or shared folder:

 1. Close all open programs except for firewall and anti-virus programs.

 2. Browse to the drive and folder where you downloaded and extracted the software package. 

 3. In the folder, locate and then double-click the Sage100Contractor[version]_Setup.exe file (or the 
Sage100Contractor_Setup.exe file, if you renamed the file after downloading it).

 4. Read the instructions on the installation welcome window, and then click [Next] until prompted to 
select an installation option.

 5. On the installation options window, select installation options as follows:

 l Select Install Sage 100 Contractor if you plan to run Sage 100 Contractor on the same 
machine as the license server.

 l Install server applications:

 l Select Database Administration if you plan to run Microsoft SQL Server (the database 
server) on the same machine as the license server.

 l Select License Administration.

 l Select Install Sage Advisor Update.

 6. Click [Next].

 7. On the license agreement window:

 a. Read the License Agreement carefully.

 b. Select the check box to accept the terms.

 c. Click [Next] to continue the installation. 

 8. If you are prompted to select a product edition, select the edition you want to use, and then click 
[Install]. 

If you are installing the software on a computer where Sage 100 Contractor was installed previously, 
the same edition is installed. (No prompt appears.)

 l The installer checks whether .NET 4.6.1 Framework is installed on the computer, and 
installs it if this program is not found. 
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 l When installation is finished, a confirmation window displays a list of installed programs, 
as well as the computer’s IP Address and network name. 

 9. Write down the IP Address and computer name. 

Important! Write down and keep the Sage license server computer’s IP Address and name in a 
convenient location. To select the Sage license server from client computers running Sage 
100 Contractor, you need to select its name from a list or type the computer’s IP Address or 
name in a text box.

 10. Click [Next].

You are prompted to activate your product licenses.

 11. Select Launch the License Administration program, and then click [Finish].  

Tip: For information about License Administration, press F1 when viewing that window.

Note: When Sage 100 Contractor is installed, an icon labeled SQL License Administration is placed in 
the Sage 100 Contractor  program folder on the Windows Start menu, and a file named 
Sage.100.Contractor.LicenseAdministration.exe in the Programs (x86)\Sage\Sage 100 Contractor 
folder. Use them to view license information or update license information for your provisioned license 
server while on a machine other than the provisioned license server.  You  can provision additional 
licenses you have recently acquired to the actual license server machine without having to be present at 
the actual license server.

Configuring Sage Advisor Update

If you installed Sage Advisor Update when you installed Sage 100 Contractor, you can receive automatic 
notifications when updates are available.

Note: We recommend that you install Sage Advisor Update on the company administrator's workstation, 
or on the workstation of the person who decides when to update the Sage 100 Contractor software.

To configure Sage Advisor Update to alert you when updates are available:

 1. On your Sage license server, in the system tray (the group of icons near the computer clock), click 

the Sage Advisor Update  icon.

The Sage Advisor Update window appears.

 2. On the navigation pane, click Configuration.
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 3. Click the Update tab, and then on the Update Settings pane:

 a. Set the frequency with which to check for updates.

 b. Under Session Timeout, specify the period of inactivity that should elapse before the program 
stops trying to connect to Sage.

 4. Click the Download tab, and then on the Download Settings pane:

 a. Under Download Location, select the server location to which to download the updates.

 b. Under Download Action, specify whether Sage Advisor Update should notify you 
automatically  when an update is downloaded.

 5. On the navigation pane, click Notification, and then on the Notification Setup pane, enter the SMTP 
settings of your email exchange server.

Note: You may need an IT professional to help with this step.

Installing Sage 100 Contractor on client workstations

Important! Before installing the software, close all open programs except for firewall and anti-virus 
programs.

To install  Sage 100 Contractor from a download package unzipped into a local or shared 
folder

 1. Browse to the drive and folder where you downloaded and extracted the software package. 

 2. In the folder, locate and then double-click the Sage100Contractor[version]_Setup.exe file (or the 
Sage100Contractor_Setup.exe file, if you renamed the file after downloading it).

 3. Read the instructions on the installation welcome window, and then click [Next] until prompted to 
select an installation option.

 4. On the installation option window, select:

 l  This computer will run Sage 100 Contractor only

 l Install Sage Advisor Update if you are installing the software on a company administrator's 
workstation.

 5. Click [Next].

 6. On the license agreement window, read the License Agreement carefully.

 7. Select the check box to accept the terms, then click [Next] to continue the installation. 
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The installer begins the installation process, checking whether the computer has .NET 4.6.1 
Framework. If this program is not found, the installer installs it. 

Note: When installation is finished, a confirmation window displays a list of installed programs

The Launch Sage 100 Contractor check box is preselected so that you can start Sage 100 
Contractor and specify the Sage license server.

 8. Read the important message, and then follow the instructions to launch Sage 100 Contractor.

 9. Click [Finish].

After installation, the following icons appear on the Windows Start menu under All Programs > Sage 100 
Contractor SQL:

 l Database 

 l License Administration

 l Sage 100 Contractor

A file named Sage.100.Contractor.LicenseAdministration.exe is saved in the \Program Files (or Program 
Files (x86))\Sage\Sage 100 Contractor folder to provide you with the convenience and ability to view 
license information or update license information for your provisioned license server while on a machine 
other than the provisioned license server.  You  can provision additional licenses you have recently 
acquired to the actual license server machine without having to be present at the actual license server.

Upgrade installations
If you currently have Sage 100 Contractor installed on your network computers and you are going to 
reinstall it, you could be either upgrading or updating the software.

Upgrade installations involve major changes, enhancements, and fixes to many parts of the program or to 
modules such as licensing. For example, installing version 22.4 over version 19 is an upgrade because 
there are major enhancements to the program.  

Update installations, in contrast, usually involve changes to specific files, such as the 
Sage.100.Contractor.PayrollTax.dll file and report forms. These files can be changed and updated without 
any changes to major parts of the program. 

In addition, upgrade installations are different from new installations.  During new installations (or 
reinstallation after completely removing Sage 100 Contractor and Sage licensing), you can designate a 
computer to be either the Sage license server or a client workstation.  

Before you upgrade your Sage 100 Contractor software, you need to complete certain preliminary tasks to 
ensure the safety of your company data.
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Important! Choose a block of time when you can install the upgrade to all the computers in your office 
beginning with your Sage license server. Depending on your computer’s hardware and your network 
configuration, plan on 15 minutes per computer for the installation process alone. Additional tasks 
may take extra time.

Before upgrading Sage 100 Contractor:

 1. Back up your company data. 

We suggest making two backup copies in case one of them is incomplete, becomes corrupted, or is 
lost. 

 2. Exit Sage 100 Contractor and all other programs. 

Important! You must not install the Sage 100 Contractor upgrade when either Sage 100 
Contractor or the  Sage 100 Contractor API are running. We recommend that you shut down all 
other programs when installing Sage 100 Contractor, but you do not have to shut down firewall 
and anti-virus software.

 3. Locate the computer on your network that is your Sage license server, and begin the upgrade 
installation there.

Upgrade Installation

Always begin all installations at the computer that is the Sage license server. After installing the upgrade to 
the Sage license server, install the upgrade to your workstations from the image placed in a folder on the 
network. For example, if you want to install Sage 100 Contractor to a network drive, you have to go to that 
computer and install the program from there.

Sage 100 Contractor running on client workstations needs to connect to the Sage license server to access 
your company data. If you do not change the designation of any computers on your network during an 
upgrade installation, all client workstations will be able to locate the existing Sage license server again after 
installation.

Installing the upgrade

Use the steps in this section to upgrade your Sage license server computer and your workstation 
computers.

Important! Install the upgrade to the existing Sage license server computer first. Install the upgrade 
to all workstations only after the license server installation has been completed.
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Before installing the upgrade

 l The upgrade installation overwrites the existing Sample Company. If you have made changes in 
your Sample Company that you want to keep, rename the Sample Company folder before installing 
the upgrade.

 l We recommend that you read the Release Notes for version 22.4 to learn about enhancements, 
program fixes, known issues, and other information that might affect your upgrade installation. You 
can open the Release Notes from the Sage 100 Contractor Product Documents web page.

To install the upgrade from a download package unzipped into a local or shared folder: 

 1. Shut down Sage 100 Contractor and all open programs except for firewall and antivirus programs.

 2. Browse to the drive and folder where you extracted the upgrade files.

 3. Double-click the Sage100Contractor[version]_Setup.exe file (or the Sage100Contractor_
Setup.exe file, if you renamed the file after downloading it).

 4. If  you are prompted to allow the program to make changes to your computer, click [Yes].

 5. Read the instructions on the installation welcome window, and then click [Next] until prompted to 
select an installation option.

 6. On the installation options window, select installation options as follows:

 l Select Install Sage 100 Contractoron any machine on which you want to run the main 
application.

 l Install server applications:

 l Select Database Administration on the single machine that will run Microsoft SQL Server 
(the database server).

 l Select License Administration when installing on the machine that will be your license 
server.

 l Select Sage Advisor Update when installing on the company administrator's machine.

 7. Click [Next].

 8. On the license agreement window:

 a. Read the License Agreement carefully.

 b. Select the check box to accept the terms.

 c. Click [Next] to continue the installation. 

 9. Click [Next]. The installation proceeds.
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 10. On the Installation complete window, click [Finish] to launch Sage 100 Contractor.

 11. Repeat steps 1 through 10 to upgrade all other computers running Sage 100 Contractor. 

Automatically Updating Sage 100 Contractor (SQL) Workstations

Sage 100 Contractor Administrators can use this convenient method to upgrade Sage 100 Contractor 
efficiently on all client machines. When you copy the latest Sage 100 Contractor (SQL) setup file into the 
Sage 100 Contractor Installation folder on your server, clients that connect to this server are prompted to 
install this version if they do not already have the current version.

To enable automatic updating of client machines:

 1. Download the latest setup EXE file for Sage 100 Contractor (SQL).

 2. Rename the downloaded file Sage100Contractor_Setup.exe.

 3. Copy the file into the Sage 100 Contractor Installation folder on the data drive (for example, 
C:/Sage100Con/Common/Installation).

Upgrading a company database from an earlier version

After installing a new version of Sage 100 Contractor, you may need to use the Upgrade Company 
Databases to upgrade existing company databases so they are compatible with the new version. (The 
Upgrade Company Databases is available in Database Administration.

Important! You do not use Upgrade Company Databases to upgrade your data from version 19.8! 
Use the Migration utility instead. For more information, see "Migrating your company data from 
version 19.8" (page 32)

Before upgrading a company database

 l Install the latest version of Sage 100 Contractor.

 l Make sure no other users are logged into any of the company databases you are upgrading.

To upgrade a company from an earlier version:

 1. Open Database Administration.

 2. Click  Upgrade Company Databases.

 3. In the grid on the tab, select the check box beside each company you want to upgrade to the current 
version of Sage 100 Contractor. 
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You can upgrade the databases for several companies at once, or you can upgrade them one at a 
time, as needed.

Tip: Use the [Clear All] button to clear your selections of databases al at once

 4. Click [Upgrade Database].

Migrating your company data from version 19.8

Important! You must be using Sage 100 Contractor version 19.8 to migrate your company to version 
22.4. If you are using an earlier version of Sage 100 Contractor, you must first upgrade your company 
data to version 19.8.

You use the migration utility in the new Database Administration tool to automatically migrate and upgrade 
your data to version 22.4, including all company data in folders and subfolders of …\MB7\[CompanyName]. 

Migrated files are located in shared folders under \\ServerName\CompanyName. These subfolders are 
organized using a similar folder structure as in earlier versions, and include:

 l Aatrix Forms

 l Attachments 

 l Direct Deposit

 l Images

 l Reports

The Direct Deposit and Reports folders are available as soon as you open the company in Sage 100 
Contractor. The remaining folders are created as needed.

Note: For detailed, step-by-step instructions on migration, see the Database and Company 
Administration Guide or the Database Administration help.

Preparing for migration in version 19.8

Migration should proceed smoothly in most cases. However, you should audit your accounting data and 
your company payroll in version 19.8, and then fix any errors, before attempting migration to version 22.4. 

Use the following audit tools to prepare your data in version 19.8:

 l 1-6 Period and Fiscal Year Management > Audit Books

 l 5-3-7 Payroll Audit

 l 6-6-3 Purchase Order Audit
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 l 6-7-4 Subcontract Audit

 l 12-5 Inventory Audit

Note: If your data includes serious audit errors, you may need assistance from your business partner or 
consultant to prepare your database for migration.

Migrating reports

The new Database Administration tool also includes a utility to migrate and upgrade Sage 100 Contractor 
reports and reports written with the Sage 100 Contractor report designer.

In version 22.4, shared custom reports and form designs are located in these folders:

 l \\ServerName\Sage100Contractor\Custom Reports

 l \\ServerName\Sage100Contractor\Report Forms

Private custom reports and form designs are located in Sage 100 Contractor User Data folders associated 
with each user name, as follows:

 l \\ServerName\Sage100Contractor\User Data\username\Custom Reports

 l \\ServerName\Sage100Contractor\User Data\username\Report Forms

Updating custom reports

You also need to update custom reports created with third-party software, such as Crystal Reports, so they 
map to the new database. 

We recommend that you use the new report views that come with version 22.4 to create or update reports. 
The new views were created for your convenience, so that future database changes will not necessarily 
break your custom reports.

After migrating your company data

After migrating your data, you will likely need to perform the following additional steps  to prepare your 
company for use in Sage 100 Contractor:

Important! Use Database Administration, not SQL Server Management Studio, for all these tasks. 

 l Add company administrators. There is no longer a generic "supervisor" user as there was in earlier 
versions. All users must sign into the company using their personal IDs, and only users designated 
as company administrators have heightened privileges previously associated with the "supervisor" 
role. You can designate one user as a company administrator during migration, but you can add 
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others later.

 l Add SQL logins for new users. If you have new users that did not exist in your version 19.8 
company, add them as users to the SQL database. 

You must also add them as users and assign security in Sage 100 Contractor.

 l Designate an additional SQL Server administrator. Only a user with system administrator privileges 
for the SQL instance can administer users for SQL Server or assign the system administrator role to 
another user. Therefore, it is vital at all times that more than one user has a system administrator 
role. If the principal system administrator should suddenly fall ill, or leave your company, or 
otherwise be unable to perform their duties, another person with administrative access to the SQL 
Server database must be able to take over that role. 

Note: The person who installs Sage 100 Contractor is automatically assigned a 'sysadmin' role in 
SQL Server. When they designate a SQL Server administrator in Database Administration, that 
person is also assigned the 'sysadmin' role in SQL Server.

 l Migrate your Sage ACT! settings to version 22.4. If you have been using Sage ACT! with Sage 100 
Contractor version 19.8 and want to use it with version 22.4, you need to change your ACT! settings 
to point to your new version 22.4 company database. 

For help on migrating your ACT! settings to version 22.4, see Migrating Sage  settings from version 
19.8.

 l Migrate each user's scheduled reports from version 19.8.  For more information, see Migrating 
scheduled reports from version 19.8.

 l Migrate each user's alerts from version 19.8.   For more information, see Migrating alerts from 
version 19.8.

Changes to converted data

During migration, the program may encounter problems that might prevent it from writing a particular 
record to the new SQL Server database. 

If the problem is one that the migration program can fix, it repairs the record, and then writes the updated 
record to the SQL Server database. (For a list of the types of errors that can be fixed during migration, see 
the Database and Company Administration Guide.)

Note: Not all errors can be fixed during migration. In these cases, the record is not written to the new 
database. 
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The migration log file

The program keeps a log of all changed records and records that were not migrated because of an 
unresolvable error, unless the record was invalid in version 19.8. (Invalid records are neither migrated nor 
logged.)

After migration, you should check the log file to see what changes were made to your data during 
conversion, or whether any records were not migrated to the new SQL database.

The _SQL_MIGRATION_LOG.TXT file is located in the source company's main folder (for example, 
C:\MB7\Sample Company). A supplemental file, _SQL_MIGRATION_LOG_VERBOSE.TXT, includes 
more detailed information about each error found.

Migrating Sage ACT! settings from version 19.8

If you have been using Sage ACT! with Sage 100 Contractor version 19.8 and want to use it with the 
current version, you will need to change your ACT! settings to point to your new version 22.4 company 
database. 

Before you migrate Act! settings

The steps in this section assume that you have:

 l Set up Act! for version 19.8, and have created opportunities, and so on, in that program.

 l Installed Sage 100 Contractor 2020 version 22.4.

 l Migrated your Sage 100 Contractor data from version 19.8 to version 22.4.

 l Reinstalled the Act! plugin.

To migrate Act! settings:

 1. Open Sage ACT!.

The first time you open Act!, a message appears saying that the database is not initialized for use 
with Sage 100 Contractor SQL.

 2. Click [Yes].

A message appears saying that you will need to restart Act!

 3. Click [OK].

Once Act! has restarted, integration menu items appear at the bottom of the Tools menu.

 4. Click Tools > Sage 100 Contractor Company Settings.
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 5. In the grid, select the Enable check box for the Version 22.4 company to which you want to migrate 
Act! settings.

 6. Click [OK].

 7. Click Migrate Company Settings.

The Migrate V19 Company Settings window appears.

 8. In the bottom grid, select the version 19.8 company whose settings you want to migrate, and then 
click [Migrate].

After migration, all your opportunities and other settings from the version 19.8 company will be available in 
the current version.

Migrating alerts from version 19.8

Alerts are saved for Windows Task Scheduler on the machine they were created on. Therefore, you must 
use Sage 100 Contractor to migrate alerts created in version 19.8 to version 22.4 for individual 
workstations. 

When you open the 7-6 Alerts Manager window, Sage 100 Contractor checks whether any alerts exist on 
that workstation for version 19.8. If it finds any, it displays a migration window that you can use to migrate 
these alerts to the current version. You can choose whether to take ownership of any alerts created for the 
Supervisor user, and you can choose to continue to run the alerts in version 19.8 as well as in version 22.4.

Note: After you have migrated all the alerts for the workstation and deleted them from version 19.8, 
the migration window is no longer available from the 7-6 Alerts Manager window.

Before you start

 l Decide whether you want to continue to run alerts in Sage 100 Contractor version 19.8 after 
migrating them to version 22.4.

 l Decide whether to take ownership of Supervisor alerts created in version 19.8.

Tip: If you have a large number of alerts, we suggest that you run Sage 100 Contractor as 
Administrator to avoid receiving a large number of Windows user access messages as you migrate 
the alerts. To run Sage 100 Contractor as administrator, right-click the Sage 100 Contractor icon on 
your Windows desktop, and then click Run as administrator.
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To migrate scheduled reports from version 19.8:

 1. Open 7-6 Alerts Manager.

Sage 100 Contractor checks for alerts created in the Task Scheduler for version 19.8. 

 2. Click [OK] to close the message telling you that the program found alerts for version 19.8.

 3. When the 7-6 Alerts Manager window opens, click the [Migrate] button that is available when there 
are version 19.8 alerts to migrate.

The Previous Version Alerts window opens.

 4. Use the Previous Version Alerts window to migrate alerts as follows:

 a. Select an option either to continue running the alerts in version 19.8 or to remove them all 
after migration.

 b. If you want to take ownership of the Supervisor alerts, select the Yes option. Otherwise, 
accept No.

 c. In the Windows User Id and Windows password fields, enter your Windows credentials.

 d. Click [OK].

Migrating scheduled reports from version 19.8

Scheduled reports are saved in Windows Task Scheduler on the machine they were created on. 
Therefore, you must use Sage 100 Contractor to migrate tasks scheduled in version 19.8 for individual 
workstations. 

When you open the 7-5 Scheduled Reports Manager window, Sage 100 Contractor checks whether any 
scheduled reports exist on that workstation for version 19.8. If it finds any, it displays a migration window 
that you can use to migrate these scheduled reports to the current version. You can select which reports to 
migrate, and you can choose to continue to run those reports in version 19.8 as well as in the current 
version.

Note: After you have migrated all the scheduled reports for the workstation and removed them from 
version 19.8, the migration window is no longer available from the 7-5 Scheduled Reports Manager 
window.

Before you start migration

Decide whether you want to continue to run scheduled reports in Sage 100 Contractor version 19.8 after 
migrating them to the current version.
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Tip: If you have a large number of scheduled reports, we suggest that you run Sage 100 Contractor 
as Administrator to avoid receiving a large number of Windows user access messages as you 
migrate the reports. To run Sage 100 Contractor as administrator, right-click the Sage 100 
Contractor icon on your Windows desktop, and then click Run as administrator.

To migrate scheduled reports from version 19.8:

 1. Open 7-5 Scheduled Reports Manager.

Sage 100 Contractor checks for scheduled reports saved in the Task Scheduler for version 19.8. 

 2. Click [OK] to close the message telling you that the program found scheduled reports for version 
19.8.

 3. When the 7-5 Scheduled Reports Manager window opens, click the [Migrate] button that is available 
when there are version 19.8 scheduled reports to migrate.

The Previous Version Schedule Reports window opens.

 4. Use the Previous Version Schedule Reports window to migrate reports as follows:

 a. In the Migrate column, select the check box beside the scheduled reports you want to migrate 
to the current version, or click [Select All].

 b. Select an option either to continue running the reports in version 19.8 or to remove them after 
migration.

 c. In the Windows User Id and Windows password fields, enter your Windows credentials.

 d. Click [OK].

Ready to “go live” with Sage 100 Contractor 2020

This section provides an overview of all the important steps you should complete to "go live" with Sage 100 
Contractor 2020. Read it carefully before you start using Sage 100 Contractor 2020  to process your data in 
a production environment (rather than in a test environment). 

Tip: Download and print the "Going Live" Checklist from our website. Then check off each step on 
the printed list as you complete the necessary tasks. 

Important! Before using this version to process your current data, ensure that all Sage branded and 
third-party applications that you use with Sage 100 Contractor are compatible with this version, and 
that they can read and write to your version 22.4 database. (See step 9 for additional information.) 
Do not use Sage 100 Contractor 2020 with live data if you also use integrated products that are 
incompatible with version 22.4. 
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 1. Pick a “Go Live” Date

With other stakeholders, decide on a go live date. 

 2. Prepare your production (live) environment

Upgrade to the latest build of Sage 100 Contractor 2020, or install it in your production 
environment.

Use Database Administration for Sage 100 Contractor to delete company data you 
migrated previously for testing in Sage 100 Contractor 2020.

Make sure that Sage Advisor Update is installed and working on each workstation that 
should receive updates. (When you install Sage 100 Contractor on a workstation, select the 
option to install Sage Advisor Update, and then make sure this icon  appears in the 
system tray.)

 3. Migrate your company from version 19.8 for the last time

Use Database Administration for Sage 100 Contractor to migrate your company to version 
22.4. 

If you have multiple companies, migrate your principal company first, and then go live with 
your other companies later.

Migrate your Sage 100 Contractor company folder.

Migrate your custom reports.

Migrate archive companies, as needed. (You can leave your archive companies in 
version 19.8 if you prefer.)

 4. Ensure that company administrators and sysadmin users have administrator rights on the server

Make sure that users who will have company administrator or sysadmin rights in Sage 100 
Contractor also have Windows administrator rights on the server that is hosting your SQL 
Server database. 

Note: You may need to work with your IT department to accomplish this task.

 5. Assign permissions to sysadmin users

Use the Database Administration  tool to assign sysadmin rights to at least one other user.

 6. Assign permissions to company administrators 
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In Sage 100 Contractor, use the 7-2-2 User List to designate former supervisor users as 
company administrators.

Tip: See the User List help for tips on copying Supervisor defaults from version 19.8 to 
company administrators in version 22.4.

 7. Migrate alerts from version 19.8

In Sage 100 Contractorversion 22.4, use the 7-6 Alerts Manager menu to migrate alerts 
from version 19.8. 

Important! Because alerts rely on Windows Task Scheduler, each user must migrate alerts 
they set up for version 19.8 on each workstation they will use. If alerts are set up to email 
users, users should make sure they receive the alerts in version 22.4, then delete the alerts 
from version 19.8 to avoid sending alerts twice.

 8. Migrate scheduled reports from version 19.8

In Sage 100 Contractorversion 22.4, use the 7-5 Reports menu to migrate scheduled 
reports from version 19.8.

Important! Because scheduled reports rely on Windows Task Scheduler, each user must 
migrate reports they scheduled in version 19.8 on each workstation they use. Make sure that 
scheduled reports print in version 22.4, and then delete them from version 19.8 to prevent 
printing them in both versions.

 9. Make sure integrated applications point to the version 22.4 database 

Ensure that all applications that read and write to your Sage 100 Contractor database now read and 
write to your SQL Server database. You may need to obtain instructions on pointing third-party 
applications to your version 22.4 database from your business partner.

Sage ACT! See Knowledgebase article 70064 for more information.

Sage Service Operations. See Knowledgebase article 70066 for more information.

Sage Paperless. See Knowledgebase article 70065 for more information.

Sage Intelligence Reporting. We recommend that you install Sage Intelligence version 20 
only after your company goes live in Sage 100 Contractor version 22.4. See 
Knowledgebase article 75640 for more information.

Other third-party applications.
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 10. Stop using version 19.8

In version 19.8, remove users from the 7-3-2 User List to prevent accidental use of the 
version 19.8 company.

Rename the version 19.8 company folder to ensure that it is not accidentally migrated 
again. Use the format CompanyNameMigratedMMDDYY so that users and Customer 
Support can easily determine that the data was migrated on, say, July 31, 2020.

 11. After going live 

Test your EFT data, if you used EFT in version 19.8, to ensure that you can create an EFT 
file with the same data as in version 19.8.

Uninstalling Sage 100 Contractor from a Sage license server
When Sage 100 Contractor is uninstalled from an active license server, the server’s licenses are 
deauthorized and made available to be acquired by another license server. If the Sage license server 
crashes and the licenses are not deauthorized, contact Customer Support to have the licenses unlocked.

Visit Sage Customer Resources (www.SageCity.com/Resources) for links to Live Chat and Online Case 
submission.

If uninstalling and then reinstalling to a Sage license server, the licenses need to be reactivated after 
reinstallation.
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Chapter 4: Act! Plug-in Installation

This chapter provides information and instructions for installing the Act! plug-in for use with Sage 100 
Contractor.

Pre-installation information
These instructions assume that you are integrating ACT! with an installation of Sage 100 Contractor 2020, 
or later. 

Before you can integrate Sage 100 Contractor with ACT!, you must also:

 l Install Act! Premium or Act! PRO (version 2011 or later).

 l Obtain an Act! plug-in license use.

Duration of the installation process
Plan on at least five to ten minutes per computer to install the Act! plug-in. The duration of the Sage 100 
Contractor installation depends a great deal upon each computer’s configuration. Installation to older 
computers may take more time.

Additional required software
Act! Premium or Act! PRO (version 2011 or later) must be installed on all computers running Sage 100 
Contractor software that use the Act! plug-in. 

Plan for an additional 10 to 15 minutes per computer to install Act! Premium or Act! PRO.   

Note: It is very important that you understand the network environments and operating systems on the 
computers and server computers where you install Sage 100 Contractor software. Special 
Configurations—Operating Systems and Services provides detailed information about installing to 
different environments. 
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Installing the Act! Plug-in 

Basic steps for installation are:

 1. Verify Sage 100 Contractor and Act! Premium or Act! Pro (version 2011 and later) are already 
installed.

 2. Activate your Act! plug-in license. 

 3. Install the Act! plug-in on any client workstations where you use Act!. 

Installation of Sage 100 Contractor and Act!

To install Sage 100 Contractor, refer to "Sage 100 Contractor Installation" (page 15) in this guide.

To install Act!, refer to the installation instructions that came with Act! Premium or Act! PRO (version 2011 
or later) and see the Act! Getting Started Resource Center at http://na.sage.com/Sage-
ACT/support/Getting-Started.

Activate your Act! plug-in license use

To activate your Act! plug-in license, refer to "Managing Your License" (page 44) in this guide.

To install the Act! plug-in on client workstations:

 1. Close all open programs except for firewall and antivirus programs.

 2. Browse to the drive containing Sage 100 Contractor (for example, Programs (x86) > Sage > Sage 
100 Contractor SQL).

 3. Double-click ACTPluginSetup.exe to begin the installation.

 4. On the welcome window, click [Next].

 5. On the Installation complete window, click [Finish].

 6. Restart your computer as necessary.
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Chapter 5: Managing Your License

This chapter provides detailed information about:

 l Managing and activating your license

 l Using License Administration

License administration
When you purchase Sage 100 Contractor software, it includes the License Administration program. Using 
the License Administration program, you can activate licenses and monitor the license uses. During 
software installation, the License Administration program is automatically installed on the computer that 
the software installer designates as the Sage license server.

Important! Before you can use Sage 100 Contractor with your activated license, you have to specify 
the computer on your network that is the Sage license server when you launch Sage 100 Contractor.

Where is the Sage license server located?

The Sage license server is software running on a computer on your network that manages the Sage 100 
Contractor products and features that you purchased. Products and features can be a “core product,” 
additional “modules,” and a number of “license uses.” The computers running your Sage 100 Contractor 
have to be connected to the computer running the Sage license server so that the correct products, 
features, and number of license uses are available to you.

About managing licenses

Use the License Administration window to activate licenses and monitor license uses.

Use the License Administration window to view and maintain your licensing information, which includes:

 l The number of license uses.

 l The users who are logged on to Sage 100 Contractor.

 l Licensing events.

The licenses give you access to the various modules of Sage 100 Contractor. 
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Your Sage 100 Contractor software automatically retrieves license information from Sage every day. As 
you purchase or remove license activations, the Sage license server automatically updates this 
information in your system. You can also update the licensing information from Sage on demand.

Activating licenses

In order to use Sage 100 Contractor, you have to activate your product licenses.

To activate your license:

 1. On the License Administration window, click the Edit registration info link.

 2. Enter your Sage client ID.

 3. Enter your Registration name.

 4. Click [OK].

License Information tab

The tab, which is available from the License Administration window, displays information about your Sage 
100 Contractor licenses.

Item Notes

Support 
plan 
expiration 
date

The date on which your support plan with Sage Customer Support expires. 

Number of 
requests 
which 
exceeded 
use count 
(last 90 
days)

Displays the number of times the request for licenses failed in the past three months 
because there were not enough licenses available. If there are a significant number of 
requests, you may want to acquire additional licenses.

Last license 
information 
update

The last date upon which your licenses were verified with the Sage license server. 

Note: If your system cannot connect to Sage for a period of more than 10 days, you will 
receive a message indicating there is a connection problem. See Troubleshooting 
license activation issues for more information.

Licensed 
modules

Displays a list of licenses available to this server, based on the products you have 
purchased from Sage. When you purchase new products, the licenses for those products 

Items on the License Information tab
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Item Notes

become available to activate here. "Canadian Edition" refers to the basic program, 
exclusive of the additional modules. The module licenses that are not part of the core 
Canadian Edition, but are available for purchase, are listed here:

 l Inventory

 l Service Receivables

 l Estimating

 l Document Control

 l Equipment Management

There is also a column that shows how many Canadian Edition licenses are checked out 
from this license server to local machines.

Update 
license 
information

Click to update the license information manually. This connects your server to the Sage 
license server, where your current license information is stored, and it updates the 
information on this window. This also creates entries in the event log. View the event log 
to monitor the success of your license activations.

Note: If you are using mufti-server license administration, ensure you have the proper 
allocations set under       Multi-server licensing before you update your license information. 

Deauthorize 
license 
server

Typically, this would be used if you are moving Sage 100 Contractor's license server from 
one machine to another machine. 

Important! You need to deauthorize the old server in the License Information tab 
before you authorize your Sage 100 Contractor license on a new server. 

Multi-server 
licensing

This allows you to allocate your Sage licenses to multiple servers. For example, this could 
happen if you have several corporate offices and want to use separate licenses for each 
office or if you want to reserve a certain quantity of license uses for a specific group of 
people.

Active Users tab

This tab of the License Administration window lists the names of all users and computers currently using 
Sage 100 Contractor. 

Each row in the list represents a separate license use. If you find you are running out of licenses, you can 
review this list to determine if any licenses can be made available. To make a license available, simply 
close Sage 100 Contractor on one of the computers where the program is running.

You can restrict all users from logging on to the Sage 100 Contractor software from this tab.
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Item Notes

User The name of the user who is currently logged on to Sage 100 Contractor. 

Computer The computer where the user is logged on to Sage 100 Contractor. 

Session The Windows session for the user. 

Restrict 
logon/Allow 
logon

Click Restrict logon to prevent users from logging on to Sage 100 Contractor temporarily. 
This prevents new users from logging on to Sage 100 Contractor but does not remove 
existing users. You might use this feature in preparation for backing up your database, for 
example. 
If you have previously restricted logon, click Allow logon to allow users to log on to Sage 
100 Contractor.

Items on the Active Users tab

Event log tab

Use this tab of the License Administration window to view events related to licensing. This lists whether 
license validation was successful or if there were any problems attempting to validate the licenses. See 
Troubleshooting license activation issues for more information about issues validating licenses.

Item Notes

Level The level of the licensing event (for example, informational). 

Date and time The date and time that the licensing event occurred.

Description The description of the licensing event. Typically, this displays "Entitlements updated 
for client," but this will also indicate if there was a problem updating the licenses. The 
section below this area provides additional details about the issue.

Clear event log Click to remove all entries in the list. 

Items on the Event Log tab

Maintaining license information

Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The 
licenses give you access to the various modules of Sage 100 Contractor. As you purchase or remove 
license activations, the Sage license server automatically updates this information in your system. You can 
also select to update the licensing information manually. 

Note: Licenses are granted to the specific computer where the licenses were initially activated. If you 
need to move your Sage 100 Contractor server to a different server, you must first deactivate the 
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licenses in the License Information tab on the old server before you can activate them on a new 
server. 

To view or change license information:

 1. Open the License Administration program.

 2. You can view or change the information here, or you can click Update license information to retrieve 
current licensing information from Sage. Note that the Sage client ID and Registration name must 
match your record at Sage exactly for the update to be successful. To change the Sage client ID or 
the registration name, select Edit registration information.

Note: If you have multiple servers serving your Sage 100 Contractor application, click Multi-
Server License Administration to allocate and update your licenses. 

 3. To view which users are logged on to Sage 100 Contractor, click the Active users tab.

 4. To view the results of the previous update attempts, click Event log. Click Clear event log if you no 
longer need the information.

Tip: For more information, click  while viewing the window.

Multi-Server License Administration window

For most users of Sage 100 Contractor, it is not necessary to allocate license across multiple servers. 

If you need to allocate licenses across multiple servers, this window allows you to allocate your Sage 
licenses to multiple servers—for example, if you have several corporate offices and want to use separate 
licenses for each office, or if you want to reserve a certain quantity of licenses for a specific group of 
people.

Because the Canadian Edition license controls the amount of license uses, it is the only license which is 
“use-counted.” Therefore the only license that is allocated among multiple servers is the Canadian Edition 
license. The additional modules are not use-based and can be used by anyone with a core Canadian 
Edition license and the appropriate security permission.

To open this window, open the License Administration program and on the License Information tab, click 
[Multi-server licensing].

Example 1—Multiple servers with specific allocations

Assume you have three servers that you want to allocate as follows:
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Server Licenses

Server A 3 Canadian Edition licenses

Server B 3 Canadian Edition licenses

Server C 4 Canadian Edition licenses

Manually allocating specific licenses to all servers

At each of the servers, you would select the Manually specify allocations for this server option in the Multi-
Server License Administration window, and select the number of licenses for that server. 

If you later purchase additional Canadian Edition licenses, you must go into each server where you want 
the additional licenses to be allocated and update the allocation.

Example 2—Multiple servers with specific allocations for all but one server

Assume you have three servers that you want to allocate as follows:

Server Licenses

Server A 3 Canadian Edition licenses

Server B 3 Canadian Edition licenses

Server C All remaining licenses

Manually allocating specific licenses to some servers

At servers A and B, select the Manually specify allocations for this server option in the Multi-Server License 
Administration window, and select the number of licenses for each server. 

At server C,  select the Allocate all available licenses to this server option in the Multi-Server License 
Administration window.

Note: In this example, it is important to select the option for server C last. If you select to automatically 
allocate all available licenses on server C first, it will take all the available licenses and there will be none 
left to allocate to servers A and B. 

If you purchase additional licenses, they will automatically be allocated to server C when the license 
activations are updated, unless you manually select the licenses to go to server A or B first. 

Items in this window

Item Notes

Allocate all If you choose this option, all licenses are allocated to this server. This is the most 

Items in the Multi-Server License Administration window
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Item Notes

available licenses 
to this server 
(default)

common scenario. Do not choose this option if you want to allocate licenses across 
multiple servers.

Manually specify 
license allocations 
for this server in 
the "Uses for 
[server name] 
column below

Select this option to allocate licenses across multiple servers. The amount of 
licenses you select in the Uses for [server name] column is the amount of licenses 
allocated to this server. 

Module name Displays a list of licenses available to this server, based on the products you have 
purchased from Sage. When you purchase new products, the licenses for those 
products become available to activate here. "Canadian Edition" refers to the basic 
program, exclusive of the additional modules. The module licenses that are not 
part of the core Canadian Edition, but are available for purchase, are listed here:

 l Inventory

 l Service Receivables

 l Estimating

 l Document Control

 l Equipment Management

There is also a column that shows how many Canadian Edition licenses are 
checked out from this license server to local machines.

Total uses The total number of uses that are available. This displays the total number of 
licenses you have purchased. 

Available uses The number of uses available to this server. If some licenses have already been 
allocated to a different server, it reduces the number of uses available here. For 
example, if you have 10 total uses, and 2 have been allocated to another server, the 
available uses for this server is 8. 

Uses for [server 
name]

The number of uses allocated to this server. You can change the number here, but 
you can only add uses if there are still uses available. You can decrease uses to 
make more licenses available to other servers.
If you need to have more uses available to this server, you must first relinquish 
licenses on one of your other servers, or purchase additional licenses. 

Uses for [server The number of uses allocated to this server. You can change the number here, but 
you can only add uses if there are still uses available. You can decrease uses to 
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Item Notes

name] make more licenses available to other servers.
If you need to have more uses available to this server, you must first relinquish 
licenses on one of your other servers, or purchase additional licenses. 

[OK] Click to allocate the licenses selected in the Uses for [server name] column to this 
server.

[Cancel] Click to cancel this window without making any changes.

Checking out and checking in a license use

You can use Sage 100 Contractor when your computer cannot actively communicate with the license 
server, by checking out a license use from the Sage license server.

Note: Checking out a product license use removes it from the license server's pool of generally available 
license uses and places it directly on the computer checking out the license. However, this may prevent 
other user access to Sage 100 Contractor, so checking out a license should only be used when 
necessary. 

To check out a license use:

 1. From the Sage 100 Contractor main window, on the File menu, click Check Out License Use.

 2. Click Yes.

Important! If you check out a license use, it remains checked out on this computer until you check 
in the license using      Check In License Use from the File menu.

To check in a license use:

 1. From the Sage 100 Contractor main window, on the File menu, click Check In License Use.

 2. Click Yes.

Administering a different license server

In the License Administration program, you can see the number of license uses, the users who are logged 
on to Sage 100 Contractor, and licensing events for this license server.

Licenses are granted to the specific computer where the licenses were initially activated. If you need to see 
the license uses available on another Sage license server,  you can do that in the License Administration 
window.
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To administer a different license server:

 1. Select the License Administration program.

 2. From the  License Administration window, click Administer Different Server.

 3. Enter computer name or IP address.

Troubleshooting license issues

Troubleshooting license activation issues

Your system will automatically retrieve license information from Sage daily. The licenses give you access 
to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage 
license activation server automatically updates this information in your system.

If the server that hosts Sage 100 Contractor is unable to connect to the Sage license server for more than 
10 days, you will receive a message indicating there is a connection problem. The following are some of 
the more common issues that can cause this to occur.

There is a problem with your Internet connection

The Sage 100 Contractor server connects to the Sage license server through the Internet. Check to make 
sure the server's connection to the Internet is intact. 

There is a problem with your network

Any network issues that interrupt the Internet connection (such as firewall settings) can prevent the Sage 
100 Contractor server from connecting to the Sage license server. Confirm that your firewall is configured 
correctly and that all network components are operating properly.

The registration information does not match

The Sage client ID and Registration Name on the License Administration window must match the 
information on the Sage license server. Ensure the information is entered correctly here. 

You have exceeded your license activations

You do not have enough licenses to support everyone attempting to use Sage 100 Contractor. You may 
want to purchase more licenses. 

Tip: The Number of requests which exceeded use count box on the License information tab of the 
License Administration window displays the number of times in the last three months that requests 
for licenses have exceeded the number of licenses available. 
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Chapter 6: License Use and Sage 100 
Contractor

This chapter provides all the necessary details about:

 l Specifying the Sage license server

 l Managing license attributes

 l Understanding license uses

Specify Sage License Server

What is a server?

There are many kinds of servers. Some servers are denoted by their hardware configuration and a 
specialized operating system. Other servers consist of specialized software applications running on 
standard computers.

Some servers are called “file servers” and may be a powerful computer dedicated to storing files and data. 
For example, Sage 100 Contractor company data can be stored on a file server. Any Sage 100 Contractor 
user on the same network as the file server can access and store data there.

A server can also be a software application that provides a specific kind of service to client software 
running on other computers. The term server can refer to a particular piece of software, such as the Sage 
license server. When we refer to the Sage license server, we are describing a computer that is running the 
Sage license server software.

Before you can use Sage 100 Contractor with your activated license, you have to specify the computer on 
your network that is the Sage license server. There are two ways to specify the Sage license server:

 l You can select the computer from the list of computers on your network; or

 l You can enter the IP Address or name of the computer.

Selecting the Sage license server computer

One method is to select the computer running the Sage license server from the list of network computers.

Note: To use this method of selecting a server from the list of network computers, you must have 
already clicked the appropriate link on the Specify Sage License Server window.
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To select the computer running Sage license server from the list of network computers:

 1. On the Select License Server window from the list of network computers, select the computer 
running the Sage license server.

 2. Click [OK].

Entering the IP Address or name of the computer

One method is to enter the IP Address or name of the computer running the Sage license server.

To enter the IP Address or name of the computer running the Sage license server:

 1. In the text box, type the IP Address or name of the computer.

 2. Click [OK].

What is an IP Address?

Every computer connected to the Internet is assigned a unique number known as an Internet Protocol (IP) 
address. This numeric address of a computer on the Internet is written as a set of four numbers separated 
by periods (each number can range from 0 to 255). An example of an IP Address is 123.123.4.5.

Determining the IP Address of a computer

Note: If you are trying to determine the IP Address computer running the Sage license server, you must 
complete this procedure on that computer.

To determine the IP Address of a computer:

 1. Click Start > Run.

 2. In the Open text box, type cmd, and then click [OK].

The \Windows\...\cmd.exe window appears.

 3. At the prompt, type ipconfig. 

For example, you might see H:\. Type ipconfig after the drive letter. 

 4. Press the [Enter] key.

The system displays several addresses including the IP Address of the computer, similar to this line:

IP Address . . . . . . . .172.20.22.142
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Determining the name of a computer

Note: If you are trying to determine the name of the computer running the license server, you must 
complete this procedure on that computer.

To determine the name of a computer: 

 1. On your Windows desktop, click Start > Settings> Control Panel. 

 2. From the list, scroll to and then double-click System. 

The System Properties window appears.

 3. Locate the line Full computer name, and then make a note of the name. 

 4. Click [Cancel]. 
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Chapter 7: Special Configurations—
Operating Systems and Services

This chapter contains information about special configurations for specific operating systems, such as:

 l Windows® 8.1 Professional and Server 2012 Standard

 l Windows 7 Professional and Windows Server 2008® R2 Standard

 l Citrix® and Terminal Servers

Windows "Sleep Mode" prevents computers from obtaining a 
license use
If the computer you are using as a license server goes into sleep mode, other computers on the network 
cannot obtain a license. 

To avoid this possibility, set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:

 1. In Windows 8.1 Professional, Windows 10, or Server 2012 Standard, click Start > All apps > Control 
Panel > System and Security > Power Options. 

In Windows 7, click Start > Control Panel > System and Security > Power Options

 2. Select Change when computer sleeps. 

 3. From the Put computer to sleep list, select Never. 

Windows 8.1 Professional and Server 2012 Standard Operating 
Systems

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on 
Windows 8.1

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers 
running the Windows 8.1 Professional or Windows 8.1 Enterprise operating systems. If the service stops, 
the program displays a message advising you to take further action to resolve this issue.
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Server 2012 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable 
communication among computers on a network. File and printer sharing on computers running the Server 
2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows 
Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard 
Operating Systems

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on 
Windows 7 Professional and Server 2008 R2 Standard

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers 
running the Windows 7 Professional or Server 2008 R2 Standard operating systems. If the service stops, 
the program displays a message advising you to take further action to resolve this issue.

Server 2008 R2 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable 
communication among computers on a network. File and printer sharing on computers running the Server 
2008 R2 operating system must be enabled. To enable file sharing, follow the instructions in the Windows 
Server 2008 R2 Help.

Turning on Microsoft .NET 3.5

Microsoft .NET 3.5 must be available and enabled prior to installing Sage 100 Contractor on a Windows 
Server 2008 R2 machine. Server 2008 R2 comes with .NET 3.5 loaded but not installed, so Sage 100 
Contractor does not install it automatically. 

If you attempt to install Sage 100 Contractor  without .NET 3.5 installed, you receive the following message 
during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you 
click [OK], the installation continues, but the services have not been installed so Sage 100 Contractor 
cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5 has been installed. 
If you receive the above message during installation, install .NET Framework 3.5., and then reinstall Sage 
100 Contractor.

The following instructions are for Windows Server 2008 R2.
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To verify that .NET 3.5 is installed on Windows Server 2008 R2:

 1. Click the Start button in the lower left corner of the display.

 2. Highlight Administrative Tools and select Server Manager.

 3. In the Server Manager interface, click Features to display all the installed Features in the right-hand 
pane.  Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5 on Windows Server 2008 R2:

 1. In the Server Manager interface, select Add Features to display a list of possible features.

 2. In the Select Features interface, expand .NET Framework 3.5.1 Features.

 3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes.  Check the box 
next to .NET Framework 3.5.1 and click Next.

 4. In the Confirm Installation Selections interface, review the selections and then click [Install].

 5. Allow the installation process to complete and then click [Close].

Note: Enabling .NET Framework 3.5.1 may require a reboot. 

Citrix and Terminal Servers

Using Citrix and Terminal Server with Sage 100 Contractor

Many people use Citrix and Terminal Server to manage remote access to their local area network (LAN). If 
Sage 100 Contractor is installed on the computer running Citrix or Terminal Server and on your laptop, 
then you may log on to the computer running Citrix or Terminal Server with your laptop and work in Sage 
100 Contractor on your LAN. This enables you to work from home, from a job site, or from any number of 
other remote locations. 

We recommend that you use DOS commands to change the operating mode from “execute” to “install” 
and then back to “execute.” When using the DOS commands to install, you may install the Sage 100 
Contractor software as you would on any desktop or Windows server operating system that meets Sage 
100 Contractor requirements.

Installing on computers running Citrix and Terminal Server using DOS commands

To install using DOS commands:

 1. Click [Start] >  Run. 

 2. On the Run window:
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 a. In the Open drop-down box, type cmd.

 b. Press [Enter].

The \Windows\...\cmd.exe window appears. 

 3. When prompted, type change user /install, and then press [Enter] to turn on the Install mode.

 4. Install Sage 100 Contractor as you would on a typical workstation or Windows Server.

 5. At the end of the installation process, launch the License Administration program. 

 6. Use the License Administration window to activate and manage your license. 

 7. After activation, click Start > Run. 

 8. On the Run window, in the Open drop-down box, type cmd, and then press [Enter].

The \Windows\...\cmd.exe window appears. 

 9. When prompted, type change user /execute to turn on the Execute mode, the default mode for 
running Citrix and Terminal Server. 

 10. Exit the Run window. 

 11. Restart the server. 

Important! If this message appears: “Install mode does not apply to a terminal server configured for 
remote administration,” it is not necessary to turn on the install mode. You may install the Sage 100 
Contractor software as you would on a typical workstation.

Backing Up Your Data
With any computer system, there is the possibility for failure and loss of data. 

Database Administration for Sage 100 Contractor includes a utility for backing up your company data to a 
network location or a local folder. (The default location is 
C:\Users\Public\Documents\Sage\100CSQL\Backup\On Demand.) These routine backups take place 
during nightly maintenance according to a schedule that you (as a company administrator) specify. You 
also specify the number of backup copies to keep. 

You should also store at least one copy of your backed-up data off premises or in a fireproof safe. If a 
burglary or fire occurs, a copy of your data is safe from harm.

Caution! Always use Database Administration to back up your data. Database Administration backs 
up numerous files (including external files, such as attachments) that are not part of the SQL 
database, and it performs additional steps to ensure that you can successfully restore your data from 
a backup copy. Do not attempt to back up Sage 100 Contractor data using Microsoft SQL Server 
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Management Studio or other third-party software, or you will be unable to restore the company.

For more information about backing up and restoring your data, see the Database and Company 
Administration Guide.

Copying your data to a CD or DVD

Sage 100 Contractor automatically backs up your data to a server location and according to the 
maintenance schedule specified for your company. You can also back up your data at any time using the 
backup function in Database Administration. 

Important! We recommend that you routinely store backed-up copies of your data in a safe 
environment that is separate from your server, preferably off site.  This topic suggests a way to copy 
your backed-up data to a CD or DVD for off site storage. 

To copy your data to a CD or DVD

 1. On your server machine, place the CD or DVD media in the CD or DVD drive.

 2. On your Windows desktop, right-click [Start] > Explore.

 3. In Windows Explorer:

 a. Locate the  C:\Sage100Con\Backup\On Demand folder.

 b. In the On Demand folder, right-click the backup that you want to copy.

 c. From the menu, click Copy.

 4. Locate and then click the CD or DVD drive.

 5. In the right-pane, right-click and then select [Paste].

Depending on your hardware and software, the backup is copied to the CD or DVD media. For further 
information or support, contact your CD or DVD manufacturer.

Configuring Windows Regional and Short Date Format

To specify regional formats for Windows:

 1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region .

 2. Click Region and Language.

 3. On the Formats tab, select the format for your country.

 4. Under Date and time formats, from the Short date format drop-down list, select  the format used for 
your country.
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 5. Click [OK].

 6. Close the Clock, Language, and Region window.
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